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Introduction 

The Advanced Configuration Guide contains additional information for setting up the 
Autodesk

®
 data management server 2011.  The topics in this guide relate to the Autodesk

®
 

data management server and can be used for all versions of Vault 2011 unless otherwise 
noted in the instructions for each configuration. As these topics cover advanced 
configurations, some familiarity with IT procedures is assumed.  For more information, refer 
to the Autodesk

®
 data management server implementation and Managing Your Data guides. 

Installing Autodesk data management server 2011 

For standard installation configurations, consult the Autodesk data management server 2011 
Implementation guide. 

Customizing your Autodesk data management server 2011 
installation 

To customize your installation perform the following: 

1. When you get to the Review – Configure – Install section in the Installation wizard, 
select the Configure button next to the product drop-down list. 
 

 

2. In the next screen, select the Autodesk data management server 2011 tab.  The 
four configuration pages will allow you to configure the license server name (if 
applicable), SQL connection settings, installation paths, and IIS port.  

 
 

 

3. You will also have the option to set the SQL sa password during installation by 
checking the box next to Use my SQL credentials.   
**This will need to be entered if the AutodeskVault SQL instance was installed prior 
to the Autodesk data management server with a sa password other than the default 
AutodeskVault@26200. Additionally, you can specify the impersonation user 
account if desired. 
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4. Vault Server 2011 has the option to automatically configure IIS to a port other than 
the default HTTP port, 80.  

 
 

5. Select the Configuration Complete button in the lower right corner of the dialog to 
return to the Review – Configure – Install dialog.  This will then show you the current 
settings that will be used during the installation.  Confirm your custom settings and 
select Install to start the installation. 

 



ADVANCED CONFIGURATION GUIDE 

Rev. 1.8 - 3 - 

Installing Autodesk data management server 2011 with other 
web applications using a different .NET version 

The Autodesk data management software will usually coexist with other web applications in 
the Default Web Site of IIS. However, there are certain applications that require a different 
.NET Framework version. This section illustrates how you can configure the Autodesk data 
management server Virtual directory to run under a different .NET version in the Default 
Application pool. You cannot run two different versions of .NET Framework in the same 
application pool with IIS 6.0. To work around this limitation, you will need to create a second 
application pool, and then configure it to run .NET Framework 2.0. Prior to running the 
Autodesk data management server installation you will have to configure the Default Web 
Site to use .NET 2.0.  
 
Internet Information Services (IIS) 6 
Note: Changing this setting will disable all other virtual folders under the Default Web Site to 
use .NET 2.0 until you change it back to the required .NET version for that application.  
 

Open the IIS management console.  

1. Open each virtual directory and note the .NET version that it is configured to use.  

2. Right-click the Default Web Site and select Properties.  

3. On the ASP.NET tab, select the .NET 2.0.50727 from the drop-down list and click 

OK.  

4. Install Autodesk data management server 2011.  
 
To create an Application Pool  

1. Open (IIS Manager in the Administrative Tools of the Control Panel.  

2. Right-click the Application Pools folder. Click New Application Pool.  

3. In the Application pool ID field, enter AutodeskAppPL.  

4. Select the Use existing application pool as template radio button and use the 
DefaultAppPool as a template.  

5. Click the OK button to apply the changes.  
 
To assign the new Application Pool  

1. Expand the Default Web Site and navigate to the AutodeskDM\Services virtual 
directory.  

2. Right-click on the Services directory and select Properties.  

3. In the Directory tab, change the Application Pool drop-down to the newly created 
AutodeskAppPL Application Pool.  

4. Apply the changes and close the properties of the Services virtual directory.  
 
To reset the .NET Framework version  

1. Open the properties of the Default Web Site.  

2. In the ASP.NET tab, select the original .Net version from the drop-down list. Note: If 
you are changing this from .NET 2.0 to a different version you will have to reconfigure 
the AutodeskDM\Services virtual directory back to .NET 2.0.  

3. Re-check all Virtual directories to make sure the correct .NET version is configured 
for the application.  
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Internet Information Services (IIS) 7 
 
To create an Application Pool  

6. Open IISManager in the Administrative Tools of the Control Panel.  

7. Right-click the Application Pools folder. Click Add Application Pool.  

8. In the Name field, enter AutodeskAppPL.  

9. Leave the other two fields at their default and make sure Start application pool 
immediately is selected. 

10. Click the OK button to apply the changes.  
 
To assign the new Application Pool  

5. Expand the Default Web Site and navigate to the AutodeskDM\Services virtual 
directory.  

6. Right-click on the Services directory and select Manage Application -> Advanced 
Settings.  

7. Under General, change the Application Pool to AutodeskAppPl 

8. Hit OK to apply the changes and close the properties of the Services virtual directory.  
 

Installing Microsoft SQL Server prior to  Autodesk data 
management server 2011 

Autodesk data management 2011 installs the Microsoft SQL 2008 SP1 Express Edition of 
SQL if it is unable to find an existing SQL instance named AutodeskVault.  If you plan on 
running a full SQL version with Vault Server 2011, it can be installed prior to the installation of 
Vault Server 2011.   

Note: This installation process may require the server to reboot multiple times.  Please be 
sure you are able to perform the necessary reboots.  Also, if you use a custom password for 
the SQL SA account, you will need to specify this password during the installation of the 
Autodesk data management server.  Please see the Customizing your Autodesk data 
management server 2011 Installation section in this document. 

Use the following steps for Microsoft SQL 2005: 

1. Start the installation process for Microsoft SQL 2005 Server. 

2. The installation process installs any necessary prerequisites and begins running the 
pre-installation checks.  Note any errors and take the necessary corrective actions 
before continuing. 

3. In the Components to Install dialog, select SQL Server Database Services.  To 
modify the installation path, click Advanced. 

a. In the Feature Selection dialog, you can expand the Database Services 
options and change the location of the data files directory. 

4. In the Instance Name dialog, enter the name of the instances as AutodeskVault. 
 
Note:  If you install SQL without using this instance name, the Autodesk data 
management server installation will create its own instance of SQL Server called 
AutodeskVault using Microsoft SQL Express 2008 SP1.  It will NOT recognize any 
SQL instance not named AutodeskVault. 
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5. In the Service Account dialog, specify the Local System account or if you plan on 
performing backups and restores to remote locations, specify a Domain User account 
for the SQL Server.   

6. In the Authentication Mode dialog, select Mixed Mode authentication and set the SA 
password.  The default password used during a default installation for the SA 
password is AutodeskVault@26200. 
 
Note: If you use a different SA password, you will need to use the use my SA 
Credentials option in the Customizing your Autodesk data management server 2011 
Installation section in this document. 

7. Download and install SQL 2005 SP3 and applicable hot fixes from Microsoft’s web 
site.  The database engine version will be 9.0.4### once SP 3 has been successfully 
installed. 
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Use the following steps for installing Microsoft SQL 2008: 

1. Start the installation process for Microsoft SQL 2008 Server by selecting New SQL 
Server stand-alone installation or add features to an existing installation from 
the installation menu. 

2. The installation process installs any necessary prerequisites and begins running the 
pre-installation checks.  Note any errors and take the necessary corrective actions 
before continuing. 

3. In the Feature Selection window, select Database Engine Services.  You can also 
specify the installation location at this point. 

4. In the Instance Configuration window, select Named instance and enter the name as 
AutodeskVault. 

Note:  If you install SQL without using this instance name, the Autodesk data 
management server installation will create its own instance of SQL Server called 
AutodeskVault using Microsoft SQL Express 2008 SP1.  It will NOT recognize any 
SQL instance not named AutodeskVault. 

5. In the Server Configuration window, select the Service Accounts tab.  

a. Specify the NT AUTHORITY\NETWORK SERVICE account for the SQL 
Server Database Engine. The local system account is also acceptable to 
use.  If you plan on performing backups and restores to remote locations 
specify a Domain User account.  Set the Startup Type to Automatic.  
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6. In the Database Engine Configuration window, select the Account Provisioning tab. 

a. Select Mixed Mode authentication and set the SA password.  The default 
password used during a default installation for the SA password is 
AutodeskVault@26200. 

b. Add the local administrator account (or desired account) as a SQL Server 
administrator.  Only Windows users entered in this dialog will have full 
rights when logging into the SQL server.  All other Windows logins will 
be treated as a guest account. 
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Note: If you use a different SA password, you will need to use the use my 
SA Credentials option in the Customizing your Autodesk data management 
server 2009 Installation section in this document. 

7. Verify the installation options chosen and Install.  Once the installer has finished, it 
can be closed. 

8. Download and install SQL 2008 SP1 and applicable hot fixes from Microsoft’s web 
site if needed.  The database engine version will be 10.0.2### once SP 1 has been 
successfully installed. 

Reconfiguring SQL Logins 

If you don’t have a domain password policy, you can skip this section.  If your domain has a 
password policy configured, you must use a password that complies with the policy.  After the 
installation is complete, reset the sa password to AutodeskVault@26200 and uncheck the 
Enforce password policy check box.  It is also necessary to create a SQL login account 
named VaultSys.  To create this account: 

1. Open the Microsoft SQL Server Management Studio. 

2. Expand the Security -> Logins folder. 

3. Right-click on the Logins folder and select New Login. 

4. Type VaultSys for the login name. 

5. Select SQL Server Authentication. 

6. Type SuperMan769400006! as the password. 
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7. Uncheck the box for Enforce password policy. 

 

8. Select the Server Roles page. 

9. Check the boxes next to the following roles:  

 dbcreator 

 processadmin  

 setupadmin 

10. Click OK to create the account. 
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Installing SQL Server on a Domain Controller 

Referencing the following Microsoft Article: 

 http://msdn.microsoft.com/en-us/library/ms143506.aspx: 

Installing SQL Server on a Domain Controller 

For security reasons, Microsoft recommends that you do not install SQL Server 2008 on a 
domain controller. SQL Server Setup will not block installation on a computer that is a domain 
controller, but the following limitations apply: 

 On Windows Server 2003, SQL Server services can run under a domain account or a 
local system account. 

 You cannot run SQL Server services on a domain controller under a local service 
account or a network service account. 

 After SQL Server is installed on a computer, you cannot change the computer from a 
domain member to a domain controller. You must uninstall SQL Server before you 
change the host computer to a domain controller. 

 After SQL Server is installed on a computer, you cannot change the computer from a 
domain controller to a domain member. You must uninstall SQL Server before you 
change the host computer to a domain member. 

 SQL Server failover cluster instances are not supported where cluster nodes are 
domain controllers. 

 SQL Server Setup cannot create security groups or provision SQL Server service 
accounts on a read-only domain controller. In this scenario, Setup will fail. 

 

Upgrading Autodesk data management server 2011 to Full 
SQL Server 

When upgrading to the full version of Microsoft SQL Server, it is assumed the appropriate IT 
and engineering staff required to allow access to the server and client systems, as well as to 
allow periodic system restarts are available.  It is also recommended that you perform the 
upgrade in a test environment prior to performing the upgrade on the production environment.  
The client side systems are needed to verify that the upgrade has been performed 
successfully. 

The server upgrade can be performed at any time after Autodesk data management server 
has been installed.  The server may need to be rebooted one or two times during the upgrade 
process. 

During the upgrade, the SQL server instance and the Autodesk Vault Server Services are 
shut down.  Anyone logged into the vault at the time is automatically disconnected.  Make 
sure all users are logged out of the Autodesk data management server.  The upgrade will not 
affect the state of checked out files, nor will it modify the database structure, state of the files, 
or parent child relationships. 

Before upgrading the SQL server, perform a backup from the Autodesk data management 
server Console application.  For more information on backing up data, see the Autodesk data 
management server console Help. 

http://msdn.microsoft.com/en-us/library/ms143506.aspx
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Upgrading MS SQL Express 2008 to Full MS SQL 2008 

 

1. Launch Setup from the Full SQL 2008 installation media.  Select the Maintenance 
option and begin the Edition Upgrade wizard. 

 

2. Verify version and or product key for Full SQL 2008 and proceed to the Select 
Instance window and choose the AutodeskVault instance. 

 

3. Upgrade the Instance.  Once the instance has been upgraded, you can install the 
SQL Management Studio by returning to the “Installation” option and being the New 
SQL Server stand-alone installation or add features to an existing installation 
wizard. 

4. Download and apply SQL 2008 SP1 if needed. 

Upgrading MS SQL 2005 to MS SQL 2008 

Microsoft does not support migrating directory from MS SQL 2005 Express to MS SQL 2008 
Standard or Enterprise.  Potential migration paths include upgrading from MS SQL 2005 
Express to MS SQL 2005 Full to MS SQL 2008 Full, and MS SQL 2005 to MS SQL 2008 
Express to MS SQL 2008 Full.  Additional migration paths can be found here: 
http://msdn.microsoft.com/en-us/library/ms143393.aspx  Also note that SQL 2008 may 
require several restarts to complete installation. 

Upgrading from SQL 2005 Express to SQL 2008 Express 

1. Download SQL 2008 Express from http://www.microsoft.com or insert your SQL 2008 
Express installation media.  The SQL 2008 Express installer is located on the Vault 
2011 installation media under <MEDIA>\x86\Support\Sql2008Express.  Please 
note that you may be required to install Windows Installer 4.5 prior to SQL 2008 
Express (KB942288). 

http://msdn.microsoft.com/en-us/library/ms143393.aspx
http://www.microsoft.com/
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2. Select the “Installation” option and begin the “Upgrade from SQL server 2000 or 
SQL Server 2005” Wizard. 

 

3. Continue through the pre-installation process.  Pre-request files and services will be 
updated.  Setup Support Rules will be processed. 

4. Select the AutodeskVault instance to upgrade, confirm instance settings. 

 

5. Continue through Disk Space requirements, Upgrade rules, and Upgrade Process.  
Setup will complete and upgrade the AutodeskVault SQL instance to SQL 2008 
Express. 

6. Verify that SQL 2008 SP1 is installed.  If it is not, please download and install it from 
http://www.microsoft.com. 

Upgrading from SQL 2005 Express to Full SQL 2008 

1. Download SQL 2008 Express from http://www.microsoft.com or insert your SQL 2008 
Express installation media.  The SQL 2008 Express installer is located on the Vault 
2011 installation media under <MEDIA>\x86\Support\Sql2008Express.  Please 
note that you may be required to install Windows Installer 4.5 prior to SQL 2008 
Express (KB942288). 

2. Select the “Installation” option and begin the “Upgrade from SQL server 2000 or 
SQL Server 2005” Wizard. 

 

3. Continue through the pre-installation process.  Pre-request files and services will be 
updated.  Setup Support Rules will be processed. 

http://www.microsoft.com/
http://www.microsoft.com/
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4. Select the AutodeskVault instance to upgrade, confirm instance settings. 

 

5. Continue through Disk Space requirements, Upgrade rules, and Upgrade Process.  
Setup will complete and upgrade the AutodeskVault SQL instance to SQL 2008 
Express. 

 

6. Launch Setup.exe from the Full SQL 2008 installation media.  Select the 
Maintenance option and being the Edition Upgrade wizard. 

 

7. Verify version and or product key for Full SQL 2008 and proceed to the Select 
Instance window and choose the AutodeskVault instance. 

 

8. Upgrade the Instance.  Once the instance has been upgraded, you can install the 
SQL Management Studio by returning to the “Installation” option and being the “New 
SQL Server stand-alone installation or add features to an existing installation” wizard. 

9. Verify that SQL 2008 SP1 is installed.  If it is not, please download and install it from 
http://www.microsoft.com. 

 

http://www.microsoft.com/
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Upgrading from Full SQL 2005 to Full SQL 2008 

1. Select the Installation option and begin the Upgrade from SQL server 2000 or 
SQL Server 2005 Wizard. 

 

2. Continue through the pre-installation process.  Pre-request files and services will be 
updated.  Setup Support Rules will be processed. 

3. Select the AutodeskVault instance to upgrade, confirm instance settings. 

 

4. ** Please note, if you do not see the “Database Engine Services” listed as a 
component to be migrated, you are not following an accepted migration path.  
Acceptable migration paths are listed here http://msdn.microsoft.com/en-
us/library/ms143393.aspx   

 

5. Continue through Disk Space requirements, Upgrade rules, and Upgrade Process.  
Setup will complete and upgrade the AutodeskVault SQL instance to Full SQL 2008. 

6. Verify that SQL 2008 SP1 is installed.  If it is not, please download and install it from 
http://www.microsoft.com. 

 

 
 

 

http://msdn.microsoft.com/en-us/library/ms143393.aspx
http://msdn.microsoft.com/en-us/library/ms143393.aspx
http://www.microsoft.com/
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 Upgrading MS SQL 2005 Express to Full MS SQL 2005 

7. Insert your MS SQL 2005 installation disc into the drive and start the installation 
wizard.  It installs the required pre-requisites first then begins the installation process. 

 

8. Click Next. The wizard performs a system configuration check.  Verify that all checks 
have a status of Success and then click Next. 
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9. In the Components to Install dialog, check the SQL Server Database Services and 
then click Next. 

 

10. In the Instance Name dialog, select the Named instance radio button and type 
AutodeskVault or you can select the Installed instances button and select the 
AutodeskVault instance and then click Next. 
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11. The Existing components dialog lists the SQL Server Database Services that are 
going to upgrade.  Check the box next to the SQL Server Database and then click 
Next. 

 

12. The Upgrade Logon Information dialog prompts you for an account that will be used 
to perform the upgrade.  You should be logged in with an account that has local 
Administrative privileges on the server.  Select the Windows Authentication Mode 
and then click Next. 
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13. In the Service Account dialog, select either a built-in System account or a domain 
user account to run the SQL Browser. Click Next. 
 
Note: If you were previously using a user account to run the SQL Server Service, 
select Use a domain user account radio button and fill in the required fields with that 
account. 

 

14. The Error and Usage Report Settings dialog displays optional settings that are not 
required by Autodesk. 
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15. On the Ready to Install dialog, click Install to begin the upgrade process. 

 

 

16. Download and install MS SQL 2005 SP3 from Microsoft’s web site, if needed. 

 

Note: For optimum performance, create a SQL Maintenance Plan after performing this 
upgrade. Follow the steps in the Creating a SQL Maintenance Plan section. 

 

Upgrading MS SQL 2005 Express SP2 or higher to full MS SQL Server 2005 SP3 

To upgrade a SQL Express 2005 SP2 installation to a full version of SQL 2005, using a disc 
which doesn’t include a service pack, SP2 or higher, you can use one of the following 
methods: 

Note: An Autodesk data management server console backup is recommend prior to 
performing either of these methods. 

 Method 1 

1. Open a command prompt and navigate to the directory where the full version of SQL 
setup is located. 

2. Type SETUP.EXE SKUUPGRADE=1” (this is case sensitive). 

3. Start the upgrade and select the AutodeskVault instance. 

4. After the upgrade is complete, apply SQL Service Pack 3. 

Method 2 

1. Create a full backup of your vault using the Autodesk data management server 
Console. 
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Note: In later steps you will be deleting all of your vault databases.  You should 
validate that this backup is able to be restored on a test server before proceeding.  
Do not continue if your test restore fails.  Correct any problems you have with the 
backup prior to continuing these steps. 

2. After the test restore is successful, open the Autodesk data management server 
Console and delete all vaults and libraries listed.  Then select Detach Master Vault 
from the Tools menu. 

3. Make sure all users are logged out of the vault. 

4. Completely uninstall SQL 2005 Express.  This includes the following applications 
in this order: 

a. Microsoft SQL Server 2005 
 
Note: If you have more than one instance of SQL Express installed, be sure 
to only uninstall the AutodeskVault instance and DO NOT uninstall any other 
part of SQL after this step is complete. 

b. MS SQL Server Native Client 

c. MS SQL Server VSS Writer 

d. MS SQL Server 2005 Backward Compatibility 

e. MS SQL Server Setup Support Files  

5. Delete the SQL Express folders from Program Files (including data files).  If your 
Vault databases are located on a different drive, be sure to delete the files in this 
location as well.  **Do this ONLY if you are not using any other SQL Express 
instances. 

6. Install the full version of SQL 2005 with an AUTODESKVAULT instance as in the 
Install MS SQL Server Prior to Installing Autodesk data management server 
section. 

7. Install Microsoft SQL 2005 SP3. 

8. Restore the backup that you created in step 1 using Autodesk data management 
server Console. 

If you have any difficulty removing the MS SQL Express instance, refer to Microsoft 
Knowledgebase article 909967 to help manually remove this instance. 

Note: For optimum performance, create a SQL Maintenance Plan after performing this 
upgrade. Follow the steps in the Creating a SQL Maintenance Plan section. 
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Assigning SQL a custom TCP/IP Port 

This section outlines the steps to set SQL to a non-standard TCP/IP port. 

 

SQL Server 2008 

1. Install full SQL Server 2005 as per the Advanced Configuration Guide. 

2. On the server where SQL is installed, start the SQL Server Configuration Manager. 

3. In the SQL Server Configuration Manager dialog, expand the SQL Server Network 

Configuration and select Protocols for AUTODESKVAULT. 

4. In the right pane double-click on the TCP\IP protocol to open its properties. 

5. In the TCP\IP Properties dialog, select the Protocol tab and change the Enabled 

property to Yes. 

6. Select the IP Addresses tab. 

7. Scroll down to the bottom of the dialog until you get to the IPAll section. 

8. Change the TCP Port field to the port you desire. 

9. Apply your changes and select OK to close the TCP\IP Properties dialog. 

10. In the SQL Server Configuration Manager dialog, select the SQL Server Services 

section in the left pane. 

11. Select SQL Server (AutodeskVault) in the right-pane, right-click on it and select 

Restart. 

SQL Server 2005 

1. Install full SQL Server 2005 as per the Advanced Configuration Guide. 

2. On the server where SQL is installed, start the SQL Server Configuration Manager. 

3. In the SQL Server Configuration Manager dialog, expand the SQL Server 2005 

Network Configuration and select Protocols for AUTODESKVAULT. 

4. In the right pane double-click on the TCP\IP protocol to open its properties. 

5. In the TCP\IP Properties dialog, select the Protocol tab and change the Enabled 

property to Yes. 

 
6. Select the IP Addresses tab. 

7. Scroll down to the bottom of the dialog until you get to the IPAll section. 
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8. Change the TCP Port field to the port you desire. 

 
9. Apply your changes and select OK to close the TCP\IP Properties dialog. 

10. In the SQL Server Configuration Manager dialog, select the SQL Service 2005 

Services section in the left pane. 

11. Select SQL Server (AutodeskVault) in the right-pane, right-click on it and select 

Restart. 

Autodesk data management server 

1. Run C:\Windows\System32\cliconfig from and the SQL Server Client Network 

Utility. 

2. In the SQL Server Client Network Utility dialog, select the Alias tab. 

3. In the Alias tab, select the Add button. 

4. In the Edit Network Library Configuration dialog, select TCP/IP under Network 

Libraries.  

5. In the Server alias box type the name of the server where SQL is installed along with 

the instance name. 
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6. Uncheck the Dynamically determine port and enter the port number you configured 

in step 8 above. 

 
7. Click the OK button to apply the settings. 

8. Start your Autodesk data management server installation. 
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SQL Maintenance Plans 

This section has been moved to the Autodesk Vault Wiki “Perform Vault Maintenance” 

Managing a remote file store 

To move the location of your file store to a mapped drive or remote shared location:  
The vault supports two basic file store configurations:  

 

1. File store located on the Autodesk data management server. 

 

2. File store located on a remote file server that has a shared folder. 

 
 

A remote file server can be used for hosting the file store and/or backing up and restoring 
vault data. This section describes the steps required to configure a remote file store. 

http://wikihelp.autodesk.com/enu?adskContextId=ID_VAULTMAINTENANCE&language=enu&product=Vault&release=Help
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Moving the file store to a mapped drive or remote share 

For simplicity purposes, the computer hosting Autodesk data management server is called 
DMMachine and the computer hosting the remote file store is called FSMachine. The 
domain name is MyDomain.  We are also assuming that the server where Autodesk data 
management server is installed is a member server and not a domain controller. 

If you have the Autodesk data management server installed on a domain control, the 
AutodeskVault domain account is used and you can go the Moving the File Store section 
below. 

Create a new domain user account. 

1. Open the Active Directory Users and Computers and select an Organizational Unit 
(OU) to create the account in. 

2. Create an account named AutodeskRemote. Set the password to match your domain 
password policy and set the password to never expire. 

Create a remote share. 

1. Open Windows Explorer on the FSMachine and create a directory called VaultData. 

2. Right-click on the folder and select Properties. 

3. Go to the Sharing tab and create a new share named VaultData. 

4. Click Permissions and set the AutodeskRemote, Network Service, and System user 
to Full Control. 

5. Click OK in the Permissions for Share dialog box. 

6. Go to the Security tab and add the AutodeskRemote account and set it to Full Control 
permission. 

Setting the new account in the Autodesk data management server Console 

1. On the DMMachine, open the Autodesk data management server Console. 

2. From the File menu, select Stop Web Service. 

3. Select Tools > Administration. 

4. In the Advanced Settings tab select the Settings button next to Advanced 
Configuration settings. 
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5. In the Advanced Settings dialog, change the User Name to 
MyDomain\AutodeskRemote and type in the selected password. 

 

6. Apply the changes and then click OK. 

Moving the vault file store 

1. Select the vault which you would like to move to a different location. 

2. Select Actions > Move File Store. 

3. Set the New File Store Location field to \\FSMachine\VaultData. 

4. Click OK. 

file://FSMachine/VaultData
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Reconfigure IIS Worker Process and Application Pool 

IIS 6 

1. Open the Active Directory Users and Computers and select an Organizational Unit 
(OU) to create the account in. 

2. Create an account named AutodeskID. Set the password to match your domain 
password policy  

3. Make the AutodeskID account a member of the IIS_WPG local group on 
DMMachine. 

4. Give AutodeskID account Full Control permissions to the %SystemRoot%\Temp 
directory on DMMachine. 

5. Give the AutodeskID account Full Control permissions to the \\FSMachine\VaultData 
remote file store directory. 

6. Open Internet Information Services (IIS) Manager and create a new Application Pool 
named AutodeskAppPL. 

7. Open the properties of the AutodeskAppPL Application Pool and go to the Identity 
tab. 

8. Add the domain account AutodeskID, set the password and apply the changes. 

9. Expand the Default Web Site and navigate to the AutodeskDM\Services virtual 
directory. 

10. Right-click on the Services directory and go to the Directory tab. 

11. Change the Application Pool pull-down to the newly created AutodeskAppPL 
Application Pool. 

12. Apply the changes and close the properties of the Default Web site. 

13. Close the IIS Manager. 

14. Open a Command prompt and type IISRESET. 

15. Add new files to the vault and verify that the properties are able to be indexed. 

IIS 7 

1. Open the Active Directory Users and Computers and select an Organizational Unit 
(OU) to create the account in. 

2. Create an account named AutodeskID. Set the password to match your domain 
password policy  

3. Make the AutodeskID account a member of the IIS_WPG local group on 
DMMachine. 

4. Give AutodeskID account Full Control permissions to the %SystemRoot%\Temp 
directory on DMMachine. 

5. Give the AutodeskID account Full Control permissions to the \\FSMachine\VaultData 
remote file store directory. 

6. Right click on the Application Pools and select Add Application Pool. 

7. In the Add Application Pool dialog, name the application pool AutodeskAppPL and 
keep the other options at their default. 

8. In the Applications Pool listing, find your newly created application pool and right click 
on it. 

9. Select the Advanced Settings. 

file://FSMachine/VaultData
file://FSMachine/VaultData
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10. Under Process Model, Select Identity and change the Identity to use the Domain 
account (AutodeskID) that you created earlier. 

11. Expand the Default Web Site and navigate to the AutodeskDM\Services virtual 
directory. 

12. Right-click on the Services directory and select Manage Application -> Advacned 
Settings. 

16. Change the Application Pool to the newly created AutodeskAppPL Application Pool. 

17. Apply the changes and close the properties of the Default Web site. 

18. Close the IIS Manager. 

19. Open a Command prompt and type IISRESET. 

13. Add new files to the vault and verify that the properties are able to be indexed 
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Installing Autodesk data management server 2011 on 
Windows Vista™ and Windows 7 

 

Note: IIS 7.0 has a limit of 10 simultaneous requests on non-server OS editions.  When the 
connection limit is reached, the request is queued until the number of currently processing 
requests drops below the limit.  IIS then will take the first request in the queue and starts to 
process it.  Previous versions of IIS would return an Error 403.9 Access Forbidden – Too 
many users are connected. 

Configuring Internet Information Services (IIS) 7.0 

If you will be using Microsoft® Internet Information Services (IIS) 7.0 with Autodesk data 
management server, IIS 7.0 may be configured before you install Autodesk data 
management server. IIS 7.0 can be installed by the Autodesk data management server 2011 
installation process as well.  If you are installing IIS 7.0 manually, follow the steps below to 
configure the system options: 
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Windows Vista / 7 

 

1. From the Windows Start menu select Settings > Control Panel.  

2. In the Control Panel, double-click Programs and Features.  

3. In the Programs and Features group, click Turn Windows Features On or Off.  

4. If prompted to allow the application to run, click Continue.  

5. Select the following options underneath Internet Information Services: 
IIS Metabase and IIS 6 configuration compatibility; IIS Management Console; 
.NET Extensibility; ASP.NET; ISAPI Extensions; ISAPI Filters; Default 
Document; Directory Browsing; HTTP Errors; Static Content; HTTP Logging; 
Request Monitor; Static Content Compression; Request Filtering.  

6.  
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Windows 2008 / 2008 R2 

1. From the Windows Start menu select Server Manager. 

2. Under Roles Summary select Add Role. 

3. Select Web Server (IIS) and add the following Roles: 
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User Account Control 

If you plan to schedule automatic backups using ADMS Console, the User Account Control 
settings in Windows Vista  \ 7 \ 2008 \ 2008 R2 must be configured to allow applications to 
run without prompting for administrator permission. Note: Configuring the following settings 
will affect all of the applications on your computer. All applications will be run without 
prompting for administrator approval. 

 

1. From the Windows Start menu, type Run.  

2. In the Run dialog box, enter secpol.msc. Click OK.  

3. When you are prompted to allow the security policy application to run, click Continue.  

4. In the Local Security Policy dialog box, expand:-  

a. Security Settings  

 Local Policies 

 Security Options  

5. Locate the User Account Control: Behavior of the Elevation Prompt for 
Administrators policy and right-click it.  

a. Click Properties.  

 Select Elevate without Prompting, and then click OK.  

6. Locate the User Account Control: Run All Administrators in Admin Approval 
Mode policy and right-click it.  

a. Click Properties.  

7. Select Disable, and then click OK 

 

Additionally, portions of the UAC can be disabled through control panel.
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Configuring Automatic Backups 

To configure automatic backups perform the following steps: 

1. Open the Task Scheduler in the Administrative Tools of the Control Panel. 

2. Create a Basic Task and fill in the necessary information in the dialog box and select 
the batch file you created for the backup. 

3. When you get to the Summary dialog, check the box next to Open the Properties 
dialog for this task when I click Finish. 

4. In the General tab of the task you just created, select the radio button next to Run 
whether user is logged on or not. 

5. Check the box next to Run with highest privileges. 

 

The following is an example of a backup script you can use for a local SQL Server. 

@ECHO OFF 
REM PROVIDING THE BEST RESULTS FOR BACKING UP THE VAULT 
REM DELETE B AND CASCADE A BACKUP SUBDIRECTORIES 
RMDIR /Q /S "C:\Backup\Vault\B" 
REN C:\Backup\Vault\A B 
REM CREATE A NEW DIRECTORY FOR THE BACKUP 
MKDIR "C:\Backup\Vault\A\" 
REM START THE BACKUP PROCESS (THIS IS ONE LINE OF TEXT) 
"C:\Program Files\Autodesk\ADMS 2011\ADMS Console\Connectivity.ADMSConsole.exe" –
Obackup -B"C:\Backup\Vault\A" -VUadministrator –VP<password> -S 
NET STOP MSSQL$AUTODESKVAULT 
NET START MSSQL$AUTODESKVAULT 

 

Note:  Unlike previous versions of Autodesk data management server, you no longer need to 
stop the web services before you perform a backup.  You can also use the –DBSC switch in 
the Autodesk data management server Console line to exclude the standard content libraries 
from being backed up during this process. 
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Setting up a remote backup location 

If you plan to back up your vault data to a remote share, follow the steps in the Creating a 
new domain user account, Create a remote share and Setting the new account in the 
Autodesk data management server Console sections in this document.  After that is 
complete, you will have to modify the SQL Service to use a domain account using the 
following steps: 

Note: The new domain account created for these steps needs to be added to the default SQL 
users group for the AutodeskVault instance.  The group created by SQL 2005 is called 
SQLServer2005MSSQLUser$<computername>$AUTODESKVAULT.  

1. Double-click the Services icon in the Administrative Tools in the Control Panel 

2. Double-click on the SQL Server (Autodeskvault) service and select the Log On tab. 

   

3. Select the This Account radio button and enter a domain account in the form of 
Domain_Name\Domain_account (with the correct password). 
 
NOTE: If you change the service’s login credentials, you will be prompted to restart 
the MS SQL Server service.  Please do so for changes to take effect.  In addition, 
ensure that clients are not using the Autodesk data management server before 
restarting SQL Server.”   

4. Verify that the account specified has write access on the share to which you are 
backing up. 
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Configuring a remote Vault connection using FQDN 

To configure the Vault Server to allow remote connections over the internet using a Fully 
Qualified Domain Name (FQDN):   

1. Create a DNS "A" or host record for your current FQDN with your ISP. 

2. Install Autodesk data management server on your server and verify that it works 
properly. 

3. On your server, open the Internet Information Services Manager and expand the 
Websites folder. 

4. Right-click on the website that contains the AutodeskDM virtual directory. Click 
Properties. 

5. In the Properties dialog box, click the Website tab. 

6. On the Website tab, click Advanced. 

7. In the Advanced Website Identification dialog box, under the Multiple identities for the 
website, click Add. 

8. In the Add/Edit Web Site Identification dialog box, select the correct IP address that 
will interact with the website. 

9. Enter the TCP port you want to use. If this is not port 80, then your clients will have to 
add ":<port#>" at the end of the FQDN in order for the connection to work. 

10. In the Host Header value, enter the FQDN.  

11. Click OK to close each dialog box. 

Note: Additional settings may be required for your router or firewall. Check with your IT 
department for the necessary changes. 

How to increase the timeout values on the Autodesk data 
management server  

As the vault database increases in size, you may have to modify some timeout values on the 
server to allow for the server to process more data. Increase the timeout values for client and 
server functions: 

1. Open Windows Explorer and navigate to the C:\Program Files\Autodesk\ADMS 
Product 2011\Server\Web\Services directory. 

2. Create a backup copy of the Web.config file. 

3. Open the Web.config file with Notepad and look for the following line: 
 

 

Note: these values may be different, depending on the size of the vault and the 
speed of the server it is installed on.  Higher values may be necessary. 

4. Save the Web.config file. 

5. Open a command prompt and type IISRESET. 

Note: If you increase the defaultCommand value higher then 1000, you must increase the 
executionTimeout value to an equal or higher value.  This is found on the following line: 
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Running Autodesk data management server with SSL 

Setting up the Autodesk data management server to use SSL (Secure Socket Layer) is a two 
step process. 

1. On the DM Server machine, install the certificate and setup the website SSL 
preferences. 

2. Verify that the clients can communicate properly with SSL. 

Configuring the DM Server machine 

It is outside of the scope of this document to instruct you how to setup SSL under IIS.  For 
more information, visit the following web resources.  Note that some steps may be different 
depending upon the version of Windows that you are currently using. 

 Obtaining Server Certificates - 
http://technet2.microsoft.com/WindowsServer/en/library/86120d58-f2c2-4a1b-8b70-
8bee6a5227981033.mspx?pf=true 
* When creating the certificate, you will need to specify the Common Name for your 
web site.  If your Vault will be accessible from the Internet, use the FQDN (Fully 
Qualified Domain Name) as the common name (ex. vault.abccorp.com).  If you are 
connecting internally only, you can use the computer name of the DM server as the 
common name. 

 Installing the Server Certificate - 
http://technet2.microsoft.com/WindowsServer/en/library/36d88d14-7dad-4168-a342-
58aee9b536021033.mspx?pf=true 

 

By default, the Autodesk data management server installer does not configure the 
AutodeskDM Virtual Directory to require SSL. After the certificate has been installed on the 
Default Web Site, users are able to login to the Autodesk data management server using 
both secured and unsecured connections.   

Unsecured logins can be accomplished by using localhost, 127.0.0.1, machine name or IP 
address in the server field of the login dialog. 

Secured logins must use the common name to which the certificate was issued.  

If Vault Web Client is installed on the server, clients will need to access it from their web 
browser with https://servername/AutodeskDM/Webclient. 

http://technet2.microsoft.com/WindowsServer/en/library/86120d58-f2c2-4a1b-8b70-8bee6a5227981033.mspx?pf=true
http://technet2.microsoft.com/WindowsServer/en/library/86120d58-f2c2-4a1b-8b70-8bee6a5227981033.mspx?pf=true
http://technet2.microsoft.com/WindowsServer/en/library/36d88d14-7dad-4168-a342-58aee9b536021033.mspx?pf=true
http://technet2.microsoft.com/WindowsServer/en/library/36d88d14-7dad-4168-a342-58aee9b536021033.mspx?pf=true
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Configure the AutodeskDM Virtual Directory to require SSL Access  

NOTE: The following procedure uses the Internet Information Services Manager to configure 
the AutodeskDM Virtual Directory to require SSL for access.   

1. Log into the computer hosting the Data Management Server as a local or domain 
administrator. 

2. From the Start Menu, select Settings > Control Panel. 

3. Double-click Administrative Tools, and then double click Internet Information 
Services. 

4. Click Web Sites under your server name. 

5. Select the Default Web Site and expand it. This web site must have the certificate 
you created installed to it. 

6. Right-click the AutodeskDM virtual directory and click Properties. 

7. Select the Directory Security tab. 

8. Click Edit under Secure Communications. 
 
NOTE: If the View Certificate button is unavailable, the certificate that you created 
has not been installed on the AutodeskDM Virtual Directory’s parent web site.  Install 
a certificate before continuing with the rest of this process. 

9. Click Require secure channel (SSL).  Clients browsing to this directory must now use 
HTTPS. 

10. Click OK. 

11. Click OK. 

12. If the Inheritance Overrides dialog is displayed, click Select All and then click OK.  
The new security settings are applied to all subdirectories of the AutodeskDM virtual 
directory. 

13. Close the Internet Information Services Console. 

Configure IIS 7.0 with an SSL Certificate. 
 
Configure the Server. 

NOTE:  The following procedure uses the Internet Information Services (IIS) Manager to 
configure IIS7 to require SSL for access. 

1.  Log into the computer hosting the Data Management Server as a local or domain 

administrator. 

2. From the Start Menu, select Control Panel. 

3. Double-click the Administrative Tools, then double click the Internet Information 

Services (IIS) Manager. 
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4. Select the IIS server listed on the left hand pane, and then double-click Server 

Certificates. 

 
5. If you already have a certificate from a Certificate Authority, you can Import your 

certificate by using the Actions pane on the right hand side of the Server 

Certificates window.  You can also create a Self-Signed Certificate from the 

Actions pane.   

NOTE:  The remainder of this document outlines using a Self-Signed Certificate 

named AutodeskDM. 

6. Select Create Self-Signed Certificate.  Name the certificate AutodeskDM, click OK. 

7. Expand the Sites tree and select the website that is hosting the AutodesDM virtual 

Directory.  In the image below, the website is Default Web Site.  Select Default Web 

Site and click Bindings from the Actions pane. 

 

 
8. Click Add and change the type to https and change the SSL Certificate to 

AutodeskDM (or your imported certificate.)  Click OK 
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9. If you wish to restrict all non SSL vault communication, click the http binding and 

select remove. 

10. Close the Internet Information Services (IIS) Manager. 
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Configuring a Client Computer with Internet Explorer 7 

To verify that the SSL client/server communication is properly setup, open Internet Explorer 
and browse to https://<servername>.  If the connection is not working, the Security Alert 
dialog box is displayed.   

 

1.  Click Continue to this website (not recommended). 

2. Click the Certificate Error message next to the Address bar and choose View 

Certificates. 

 
3. Click Install Certificate.   
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4. Follow the Certificate Import Wizard and Place the certificate in the Trusted Root 

Certification Authorities. 

5. Allow the certificate to finish loading by selecting Yes at the following prompt, if 

asked. 

 

Configuring a Client Computer with Internet Explorer 8 

To verify that the SSL client/server communication is properly setup, open Internet Explorer 
and browse to https://<servername>.  If the connection is not working, the Security Alert 
dialog box is displayed.   

 

1. Click Continue to this website (not recommended). 

2. Export the certificate from the server. 
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a. Open IIS Manager from Control Panel -> Administrative Tools -> Internet 

Information Services Manager. 

b. Highlight the computer name. 

c. On the right hand side find the Server Certificates Option and double click. 

 
d. Find the certificate that you are using in the list and highlight it. 

e. Right click and select Export. 

f. Select a shared location to save the certificate and enter a password for the 

certificate. 

  
3. Open the share from the client PC and find the newly created certificate. 



ADVANCED CONFIGURATION GUIDE 

Rev. 1.8 - 43 - 

4. Double click to open the certificate and start the Certificate Import Wizard. 

 
5. Click next on the File to import screen as the file shown should be the certificate you 

selected earlier. 
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6. Enter the password you created for the certificate when you exported it from the 

server. 

 
7. Select Place all Certificates in the following store and select the Trusted Root 

Certification Authorities. 

8. Finish the wizard. 

Login from client applications using SSL  

1. In the Log in dialog box, enter your user name, password, and the name of the database.  

2. For the name of the server, specify the machine name of the server with the prefix: https://. 
For example:  

https://ServerName  

If you are using a different SSL port: https://ServerName:XXX where XXX is the SSL 

communication port number.  
 

NOTE: The secured login depends on the certificate issued to the server machine. If it is 
issued for the machine name, then only https://ServerName will work. Otherwise, if the 
certificate is issued for a dedicated IP, then only https://serverIPAddress will work as a 
secure vault login. 



ADVANCED CONFIGURATION GUIDE 

Rev. 1.8 - 45 - 

Using Vault with a Proxy Server 

This section describes setting up a proxy to enable successful Autodesk Client/Server data 
communication. 

If a client machine connects to the web server through a proxy server, then all calls to the 
Autodesk data management server from any Autodesk client will fail.  To have a successful 
Autodesk Client/Server communication, you need to bypass the proxy server.  

Change the proxy settings in Internet Explorer 7.x, 8.x 

1. Open Internet Explorer. 

2. From the Tools menu, select Internet Options. 

3. Select the Connections tab. 

4. Click LAN Settings.  

5. If Automatically Detect Settings is selected, remove the check box. 

6. If the Use a proxy server for your LAN check box is enabled, turn on the Bypass 
proxy server for local addresses check box. 

7. Click the Advanced button next to the Port field. 

8. In the Proxy Setting dialog, add the server name and IP address into the Exceptions 
field. 

9. Click OK.  

10. Click OK. 

11. Click OK to close Internet Options. 

All addresses without a period, for example: http://webserver, will bypass the proxy and be 
resolved directly. 

If Internet Explorer continues to connect to the assigned HTTP proxy server, then the HTTP 
proxy address may contain a period.  If this happens, configure the proxy server to use a host 
name. 

Configure the proxy server to use a host name 

1. Follow steps 1-5 above for changing the proxy settings in Internet Explorer. 

2. If the “Address” field is http://webserver.domainname.com or http://10.0.0.1, then 
change it to http://webserver only. 

3. Click OK and close Internet Explorer Options. 

 

For more information on advanced proxy bypass configurations: 

 Read Microsoft Knowledge Base article 262981: Internet Explorer Uses Proxy Server 
for Local IP Address Even if the 'Bypass Proxy Server for Local Addresses' Option Is 
Turned On  

 

 Read the Microsoft document Working with Proxy Servers 
(http://technet.microsoft.com/en-us/library/cc939852.aspx) 

 

http://webserver.domainname.com/
http://10.0.0.1/
http://webserver/
http://support.microsoft.com/default.aspx?scid=kb;en-us;262981
http://support.microsoft.com/default.aspx?scid=kb;en-us;262981
http://support.microsoft.com/default.aspx?scid=kb;en-us;262981
http://technet.microsoft.com/en-us/library/cc939852.aspx
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Bypassing a Proxy Server with the Application config file 

 

By default HttpWebRequest's uses the proxy setting specified inside of Internet Explorer.  
You can change those settings by going to Control Panel -> Internet Options -> Connections 
Tab -> LAN Settings Button. You can disable auto detection by un-checking the 
"Automatically Detect Settings" button. In most cases this allows the client application to 
function properly. However, in some cases you may experience slow connectivity and 
delayed responses from the application when connected to Autodesk data management 
server. There is an option to disable proxy configuration through your application.exe.config 
file: 

In this example, for Inventor, the config file is located in the following directory. Each client 
application has a similar config file. Make a backup copy of the file and then edit the file using 
Notepad.exe ONLY. 

"C:\Program Files\Autodesk\Inventor 2011\Bin\Inventor.exe.config" 

 

Add this line of code to the file: 

<system.net>  

  <defaultProxy>  

    <proxy autoDetect="False"/>  

  </defaultProxy>  

</system.net> 

 

After you have added the text, save and close the file. The changes will take effect the next 
time the application is started. 
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Autodesk data management server Log Files 

This section shows you where to find the various log files and other files used for 
troubleshooting potential problems with Autodesk Vault. 

For the purposes of this section, we refer to the %temp% folder. This is the temp folder 
location defined for the Windows user account that is logged in on the computer. By default, 
this folder is located in the following location for Windows XP and Server 2003 

C:\Documents and Settings\ACCOUNTNAME\Local Settings\Temp  

And the following location for Windows Vista, 7, Server 2008, and Server 2008 R2. 

C:\Users\ACCOUNTNAM\AppData\Local\Temp 

In this example, ACCOUNTNAME is the name of your user account in Windows. 

Vault server log files 

There are primarily two different log files to look for in this location. Each of these is described 
in full detail below. 

 

Folder location and file names: 

Microsoft Windows™ XP / Server 2003  - C:\Documents and Settings\All 
Users\Application Data\Autodesk\VaultServer\FileStore 

Microsoft Vista™ / Windows 7 / Server 2008 / Server 2008 R2 - 
C:\ProgramData\Autodesk\VaultServer\Filestore 

Vlog-YYYYMMDD.txt 

Any server-side problems relevant to Check-in, Check-out, Get Latest Version, Undo Check-
out, Advanced Search and other operations performed from within Vault Explorer or one of 
the supported product add-ins are written into these log files. 

 
ADMSConsoleLog-YYYYMMDD.txt 

Any server-side problems relevant to backup, restore, re-index, purge or other operations 
performed within Autodesk data management server Console are written into these logs. 

 
Emaillog-YYYYMMDD.txt 

Email sent from the server. 

 

Autodesk data management server 2011 installation log files 

During the installation of Autodesk data management server there may be errors reported the 
by the diagnostic tool or during the installation itself. These errors are recorded in log files. 

Pre-check log: 

%temp%\EDMlog 
Prechecks.xml 
Prechecks.xsl 

Autodesk Vault <Version> 2011 client installation logs: 
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%temp% 
Autodesk Vault <Version> 2011 Install.log 
Autodesk Vault <Version> 2011 Setup.log 

Autodesk Vault <Version> 2011 server installation logs: 

%temp% 
Autodesk Vault <Version> 2011 (Server) Install.log 
Autodesk Vault <Version> 2011 (Server) Setup.log 

Autodesk Server Diagnostic Tool Log files 

If you run the Autodesk Server Diagnostic Tool, the log files are located in the 
%temp%\EDMLog directory. 

Autodesk Server Diagnostic Tool: 

%temp%\EDMLog 
DiagTool.xml 
DiagToolLog.xsl 

 

Microsoft SQL Server log files 

Folder location and file names: 

C:\Program Files\Microsoft SQL Server\%SQL_INSTANCE%\LOG 

Errorlog 

Errorlog.1 

Errorlog.2 

Errorlog.3 

 

The SQL logs are named sequentially with the most recent (current) file being named errorlog 
followed by errorlog.1 then errorlog.2 and so on. 

DWG iFilter Log files 

There are log files maintained by the various iFilters used when performing some Vault 
operations like re-index. These log files can be helpful when troubleshooting problems with 
block attributes or properties not indexing as expected in Vault Explorer. 
 

Folder location and file names: 

Depending on your server setup, your iFilter log files may be contained in a different location. 
 
C:\Windows\Temp\  OR %TEMP% 

DWGFILT.*.log 
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Indexing Block Attributes (DWG files) 

When troubleshooting problems with DWG block attributes not indexing in a vault, you'll also 
want to find the FilterConfig.xml. This file is created when you index block attributes in the 
Autodesk data management server Console and is found in the following location: 

 

Folder location and file name: 

C:\Program Files\Autodesk\Data Management Server 
(X)\Server\Web\Services\FilterConfig.xml 
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Customize W3C Extended Logging 

The W3C Extended log file format is the default log file format for IIS.  It is a customizable 
ASCII text-based format.  You can use IIS Manager to select which fields to include in the log 
file. [W3C Extended Log File Format] 

 

1. From the Windows Start menu, select Control Panel > Administrative Tools > Internet 
Information Services 

2. In IIS Manager, expand the local computer, expand the Web Sites folder, right-click 
the Default Web site, and click Properties. 

 

3. On the Web Site tab, select the Enable logging check box (if it is not already 
selected). 

 

http://technet2.microsoft.com/WindowsServer/en/Library/c9ae63eb-24da-4f19-80b9-2610b4e6dcab1033.mspx
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4. In the Active log format drop-down list, select W3C Extended Log File Format and 
click the Properties button. 

  

(BEFORE) 

NOTE: Before changing the extended properties, write down or take snapshots of currently 
selected W3C properties in case of wanting to go back to the original state in the future. 

5. On the Advanced tab (for Windows 2003 server) or Extended Properties tab (for 
Windows XP), select logging ALL properties. 

  

(AFTER) 

 

6. Click OK and close IIS Manager. 
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7. From the Windows Start menu, select Run. Type: iisreset and then click OK to 
restart IIS. 

 

8. IIS logs are located in the following directories: 

a. C:\WINDOWS\system32\LogFiles\W3SVC1 – for the Default Web site 
communication. 

b. C:\WINDOWS\system32\LogFiles\HTTPERR – for IIS errors logs. 
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Vault Collaboration and Professional 2011 Multisite 
Replication 

This section addresses topics specifically related to the unique environments associated with 
replicating data to multiple work sites.  

Scalability of Replication 

Replication uses a single database for all sites and replicates the file store to each location.  
This architecture has distinct advantages in ease of implementation, end user experience and 
the instantaneous nature of the information availability.  This architecture is not suited to 
multiple sites that are distributed over great distances or poor networks.  It is recommended 
that the replication environments are not distributed across multiple continents.     

If you are unsure of the appropriateness of Replication in your environment you can easily 
estimate the performance. The performance can be gauged between two remote sites by 
browsing a network share between the sites.  If the responsiveness of the remote share is 
deemed acceptable for daily access Replication should also be acceptable.  Vault 
communicates via http which is more efficient than the default windows system which is 
observed when browsing a remote share. 
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Content Center in a Replicated Environment 

Introduction 

Autodesk Inventor Standard Content is delivered in the form of library databases that are 
hosted by the Autodesk data management server.  Users access these library databases 
through Inventor to automatically create selected library components as Inventor part files.  
Once instanced these components are stored in a folder defined by the Inventor project file.  
When the assembly is then checked into Vault, the instanced Content components are also 
checked into Vault.  

In a Replicated Autodesk Vault environment we can tune the performance of Content Center 
by altering the configuration of the Inventor project file.     

Assumptions 

The following examples assume all software including the Content has been installed.  These 
examples also assume the reader has a functional understanding of how Content is 
instantiated and referenced.  If required please reference the Content Center help files.  

 The following diagrams show the SQL server as a separate computer for clarity.  SQL Server 
may be on a separate computer or on the Autodesk data management server, either case is 
supported and has no impact on the workflows detailed in this document.    

Private Content Center Folder 

The default configuration when using Inventor is for each client to have a private Content 
folder.   

Advantages: 

 Suitable for assemblies that have a high volume of Content components by 
eliminating network traffic for existing local components. 

 Allows each user to have only the content they use in their Private Content Folder. 

Disadvantages: 

 Consumes considerable disk space on the client 

 Each client must instantiate each referenced component in their Private Content 
Folder 
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Private Content Example 

 

 

1. Client 1 creates an instance of a component from the Content Center database.  The 
instanced part file is written to the Private Content Center folder located on the client 
computer.  

2. User checks in the instanced component as part of an assembly.  The Content part is 
copied into the Vault file store.  

Note: Keeping the part file in the local folder will remove the delays, for this user, due 
to instancing the part file or copying it from the file store.  

3. Client 2 inserts the same component that Client 1 used.  Since the part does not yet 
exist in the Private Content Center Folder for Client 2 it must be instanced from the 
database.   

4. Once instanced the assembly may be checked into Vault.  Vault knows that this 
component already exists and will resolve the assembly with the existing component 
in the file store. 

5. During the scheduled replication at each Autodesk data management server the 
Content components will be copied to the local file store at each site.  

6. Client 3 inserts the same component that Client 1 & 2 have previously used.  The 
component must be instanced from the remote database.  This is the same process 
as Client 2 in step 3 but the instantiation delay may be increased based upon the 
distance and network latency between the client and the SQL Server. 



ADVANCED CONFIGURATION GUIDE 

Rev. 1.8 - 56 - 

Seeding the Content Center Folders 

The re-instancing of existing components can be avoided by performing a Get Entire Folder 
from the Vault thick client. This will seed the Content Center Folder with all instanced Content 
that has been checked into the Vault.  This applies to both the Private and Shared Content 
Center Folders.  In environments where new content is created frequently it may be 
advantages to perform this operation on regular basis.  
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